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Tassels & TeXTuRes TaBle TOPPeR
4  Create a two-sided table topper using BeRNINa design collection, From 

Tassels to Textures, and reversible embroidery.

squaRes & CIRCles swINg JaCkeT
8  start with a basic jacket pattern, add a bit of flare, then create a one-of-a-

kind swing jacket by adding unique embroidered borders.

“PuTTINg IT IN ReveRse” aPPlIque JOuRNal COveR
10  Create a custom cover for a simple journal to express the style, creativity, 

and interests of the writer. 

CReaTIve CuTwORk
12  Cutwork embroidery is reminiscent of days gone by, and very pretty in its 

traditional form of tone-on-tone embroidery. New embroidery collections, 
such as the Heritage Creations Cutwork Collection #850, offer the same 
beautiful designs sewn with today’s technology. 

ReTaIl ResTyle X3
15  got more dash than cash? stroll through any shopping mall this season 

and you’ll see the season’s darling garment – sweaters! They’re the perfect 
backdrop for embellishments that you add with your BeRNINa.

T-sHIRTs: sTyles & sTITCHes
20   short sleeves, long sleeves, every length in between. straight, flared,  

embellished - the humble T-shirt gets easy designer makeovers at your 
machine.

CuTsIe OOPsIe BuRP ClOTH
24  with a little help from your BeRNINa and version 5 software, transform 

a simple cloth diaper into a personalized baby cloth for a special little 
someone.

PuRPle PIzzazz
26  How best to remember what needs to be done before leaving the house in 

the morning? where should you stow those bits and pieces that accumulate 
in the hallway, bathroom or office? we’re all faced with these questions, and 
we’ve injected a bit of purple cheer into their solutions. 

THe FOld-OveR…a FelTINg TeCHNIque FROm FIBeRella
28  enjoy a thin but delicious slice of needlepunch from Paula scaffidi’s 

upcoming book, a 2009 release. like all of Paula’s roving, yarn and fine 
fabric techniques, you’ll find it simple, lush and beautiful.

wINe wRaP
32  Presentation is everything! make a great impression when you present a gift 

of wine or sparkling cider adorned with this elegant tasseled wine wrap. 

New sTaBIlIzeRs
34  Find out what’s new in the recently updated Oesd stabilizer line. several 

exciting new products will improve your embroidery.
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needle notes
Happy New year! what are your sewing resolutions for 2009? One of mine is to 

experiment more – to play with techniques before I sit down to create a final project. 

There are lots of opportunities for learning new skills in this edition of Through the 

Needle, and many more planned for future issues. 

you’ll notice that Through the Needle has a slightly new look for 2009, including an 

updated cover and logo. we’ve also removed the Contributors page to make room for 

more articles; but we’ll continue to include biographical information and photos for 

all non-BeRNINa staff who write for the magazine. look for bios with each article. 

The theme of this issue is embroidery & software – who would have guessed, 10 

years ago, that home embroidery software would be so powerful and easy to use? 

Highlighted in this issue are embroidered cutwork (page 12), reverse appliqué (page 

10), monogramming (page 24), and reversible embroidery (page 4), as well as 

projects featuring designs from the studio BeRNINa Tassels & Textures embroidery 

collection (pages 4 and 32). we also have a jacket embellished with designs from 

the new BeRNINa 830 (page 8). most of the embroidery projects can also be done 

without software by substituting different embroidery designs, using onscreen 

embroidery functions, and careful rehooping. does all of this embroidery inspire you? 

look for BeRNINa-sponsored embroidery T-n-T seminars in your area – check with 

your local BeRNINa dealer for details. 

For those of you who don’t embroider, we have a variety of other articles, including 

a special needle-felting article by Paula scaffidi, aka Fiberella (www.fiberella.com) 

(page 28). There are also projects for garment stitchers (pages 15 and 20) and 

crafters (page 26), plus information on new products from Oesd (page 34). 

we hope you enjoy this issue of Through the Needle and we wish you a wonderful new 

year of sewing!
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sew Red Journal

Necklace kit

Heart disease is the #1 killer in the 
united states. February is “american 
Heart month.” Here are a few ways to 
support the american Heart association 
and have fun at the same time! Through 
BeRNINa’s sew Red program, a portion 
from the sale of each featured product 
is being donated to the american Heart 
association.

sew Red Journal kit from aRTgIRlz
kit includes: a colorful 20-page blank journal, hand-made paper, wool felt, painted 
tag, mixed yarns, beads, paper borders, words, and illustrations. 

sew Red Necklace kit from aRTgIRlz
kit includes: wool felt beads, mixed glass beads, mixed yarns, spikey heart and 
winged heart charms, and instructions on how to create your own artgirlz necklace.

sew Red silk Collection
Featuring 16 colors of dupioni silks – each 18" x 22". makes a quilt top 64" x 64" – 
designed by Blue underground studios to make their pattern In and Out (below). 

In and Out sew Red Pattern from Blue uNdeRgROuNd
This fantastic pattern from Blue underground studios teams up with the sew Red 
silk Collection!

sew Red by BeRNINa – 2009 Calendar
get organized and support the american Heart association at the same time! This 
12-month calendar features photos of twelve BeRNINa sewing machines that have 
been “blinged” – painted, stitched, jeweled, and stamped by some of today’s most 
well-known sewing artists. For each calendar sold, BeRNINa of america will donate 
$5.00 to the american Heart association.

spotlight on…

silk Fabrics

In & Out quilt
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By erika Mulvenna

Create a two-sided table topper using 
reversible embroidery and designs from 
the BERNINA® collection, From Tassels to 
Textures , by Louisa Meyer.

(Finished size approximately 22" X 22")

•  Two contrasting pieces of medium-
weight fabric 25" X 25" square (moss and 
cream shantung shown)

•  Purchased ribbon or trim to finish edges 
(bias tape, ribbon, or home dec trim) 

•  Purchased embroidery floss and beads 
for tassel trims

•  OESD PolyMesh Cut-Away stabilizer, 14" 
or wider

•  OESD AquaMesh Wash-Away stabilizer

•  Isacord thread: 0015 White, 0250 Lemon 
Frost, 0270 Buttercream, 1172 Ivory, 
1761 Tea Rose, 2051 Teaberry, and 5912 
Erin Green 

•  BERNINA® Editor Plus V5 or Designer 
Plus V5 software

•  BERNINA® artista machine with 
embroidery and Large Oval Hoop

•  BERNINA® From Tassels to Textures 
Design Collection

Materials

Designs used for topper

Reversible 

  Table 
  Topper
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Create Center Design
•  Open the BERNINA® embroidery 

software and begin with a new, blank 
design using the Large Oval Hoop.

•  Change the default Thread Chart 
to Isacord 40-wt numerical by right 
clicking Settings > Thread Colors, and 
selecting Thread Chart = Isacord 40 
wt-numerical. 

•  Insert design fullf; while still selected, 
change the thread color to Isacord 
1172 Ivory.

•  Insert design tassel2link; while still selected, change the thread 
color to Isacord 0270 Buttercream.

•  Position the tassel-
2link design directly 
underneath the first 
design. To align 
centers, select both 
designs and left click 
on the Align Centers 
(Vertical) tool. Dese-
lect both designs. 

•  Duplicate and 
repeat tassel2link 
with the Wreath 
tool: Select the 
design, left click 
on the Wreath tool, 
choose number 5 in 
the Wreath Points 
box, then move the 
mouse until you 
have arranged the 
repeated designs in 
a pleasing manner. 
Left mouse click to 
finalize the design.

•  Insert design panelflower4X4, and while still selected, change 
the thread colors to:

 Color 3 = Isacord 0015 White
 Color 4 = Isacord 2051 Teaberry
 Color 5 = Isacord 5912 Erin Green
 Color 6 = Isacord 1761 Tea Rose
 Color 7 = Isacord 0250 Lemon Frost 
 Color 15 = Isacord 0015 White
•  Reduce the size of the design while still selected by left clicking 

the Scale by 20% Down/Up tool once. 
•  Rotate the design while selected by right clicking the Rotate 45° 

CCW/CW tool once. 
•  Move the design to 

the top of the other 
designs and align: 
With the design 
selected, hold down 
the Control key and 
left click on the cen-
ter design so that 
both are selected, 
then left click on the 
Align Centers (Verti-
cal) tool. Deselect 
both designs.

•  Duplicate and 
repeat panelflow-
er4X4 design with 
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the Wreath tool:  
select the  
design, left click 
on the Wreath tool, 
choose number 
5 in the Wreath 
Points box, then 
move the mouse 
until you have  
arranged the repeated designs in a pleasing manner. Left 
mouse click to finalize the design.

•  Save your design as “table top center.” When the Object Not 
Covered screen appears, click on the Everything button. 

Create Center Multi-Hooping
•  With the table 

top center design 
open, left click on 
the Multi-Hooping 
View tab.

•  Select and move 
the first hoop over 
to the left using the 
left arrow key or 
dragging with the 
mouse until the left 
side of the design 
is completely cov-
ered by the hoop.

•  Add a second 
hoop by left click-
ing the Add Hoop 
button.

•  Select and move 
the second hoop 
even with the first 
hoop and then 
over to the right 
using the arrow 
keys or dragging 
with the mouse 
until the right side of the design is completely covered by the 
second hoop.

•  Left click on Calculate Hoopings to determine the number of hoop-
ings for stitching the design; the number of hoopings will be 2.

• Save changes to the design “table top center”.
•  Switch to Design 

View to send the 
multi-hooped 
design to the  
machine.

•  Select File > Card/
Machine Write. 

•  The Hooping Se-
quence – To  
Machine window will open a list of all of the hoopings required 
to stitch the design and show added registration marks.

•  The first hooping is selected; click the Send Now button to 
send directly to a BERNINA® design stick or to a machine.

•  Repeat the process to send all additional hoopings.

Create Corner Design
•  Open design Bowflower, select the Isacord – 40 wt-numerical 

thread chart, and change the thread colors as follows: 
 Color 1 = Isacord 0015 White
 Color 2 = Isacord 0270 Buttercream
 Color 3 = Isacord 1172 Ivory
 Color 4 = Isacord 5912 Erin Green
 Color 5 = Isacord 0250 Lemon Frost
 Color 6 = Isacord 1761 Tea Rose
•  Select the Large 

Oval Hoop.
•  Rotate the design 

while selected by 
right clicking the 
Rotate 45°CCW/
CW tool once.

•  Save your de-
sign as “table top 
corner.”

Multi-Hooping Tips
•  Print out templates from the BERNINA® embroidery software to 

help align the design on the fabric.
•  The registration marks will stitch out in red for the first hooping 

and in blue for the second hooping.

Stitching Reversible Embroidery
•  Use the same color thread in the bobbin as in the needle to 

create embroidery that is reversible. 
•  Check tension by embroidering a small sample with the same 

thread in the bobbin and needle; make any adjustments before 
beginning your final project.

• Wind bobbins in advance to save time.

Create the Table-Topper

•  Using a small amount of temporary spray adhesive, center one 
piece of PolyMesh Cut-Away stabilizer on top of the wrong side 
of the first fabric square.

•  Line up the remaining square of fabric carefully on top of the 
first piece, wrong side down, using a small amount of  
temporary spray adhesive on the stabilizer to help hold it in 
place.



•  Hoop through all layers to stitch the center design; be sure to 
use templates to help center the embroidery.

•  Thread needle and bobbin with the same color thread. Stitch 
center design. 

•  When stitching is complete, carefully remove from the hoop 
and open the layers of fabric to trim away the excess stabilizer.

•  Trim excess jump stitches and threads away from both sides of 
embroidery.

•  Lay the project right side up on a flat surface, smoothing fabric 
to each corner.

•  Cut a piece of PolyMesh Cut-Away stabilizer larger than the 
hoop; center the stabilizer on the corner between the layers 
of fabric – the stabilizer should extend past the corner of the 
fabric by several inches.

•  To place the “table top corner” design, use a printed template 
or gridded hoop template to center the design on each corner 
about 1¼" from each edge.

•  Again, use the same thread in the bobbin as in the needle to 
create reversible embroidery.

•  When stitching is complete, carefully remove from the hoop 
and open the layers of 
fabric to trim away the 
excess stabilizer. Be 
careful when cutting 
between fabric layers!  
Cut only the stabiliz-
er and not the threads 
or fabric.

•  Trim excess jump stitches or threads away from both sides of 
embroidery.

• Repeat for each corner.

•  When finished with all embroidery, square up the project using 
a straight edge and fabric marking pencil; square and mark all 
four sides ½" in from edges. Pin, then baste around this line 
using a basting straight stitch on a sewing machine. Trim close 
to stitching.

•  Finish edges with 
trim – double fold 
bias tape, home dec 
trim, or ribbon. In this 
sample, 1" cream-
colored satin ribbon 
was folded in half 
and stitched around 
the entire edge.

Create the Tassels
•  Follow the instructions on page 38 of the From Tassels to 

Textures booklet accompanying the embroidery designs to 
construct the tassels.

•  Stitch design tas-
selcap with Isacord 
thread color 1172 
Ivory on OESD 
AquaMesh stabilizer 
to create the caps for 
the tassels.

•  Use matching em-
broidery floss or Isacord thread with the Tassel Tool on page 38 
to create 4” tassels.

•  Add purchased beads to the tops of the tassels in colors to 
match the embroidery. 

•  Hand-stitch the tassels in place with needle and thread, one on 
each corner of the table topper.

i s s u e  2 9
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Modify Jacket Pattern
Customize the Boxy Jacket  
pattern from the My Label 3-D Fashion 
Pattern Software. Using the Style Properties 
measurements, make the following changes to 
the pattern: change the sleeve to a ¾ length, 
widen the hem edge, and widen the jacket to 
create a swing. Use the collar from the Military 
Jacket for the Boxy Jacket. Print the pattern 
and cut the fabric out.

Replace the hems on the jacket with facings. The embroidery width is 6"; draw facings that 
cover all the embroidery on the inside of the unlined jacket. To do this, place a ruler on the 
seam line and draw a facing that is 6" plus 5/8" seam allowance. Cut the facings. The hems 
will be eliminated after the embroidery is done.

Create Embroidery Templates
Scan the sleeve pattern hem edge, jacket 
front hem edge, jacket back hem edge, 
and the entire collar from the Picture view in 
the Designer Plus software. Use the Open 
Object tool > Single Outline to trace around 
the cutline of the pattern. Be sure the seam 
lines are visible (draw them in if necessary); 
they will be important for placing the 
embroideries. Create a separate file for 
each pattern piece. 

Supplies
• BERNINA 830
• Jumbo Hoop
• V5 DesignerPlus Software
•  My Label 3D Fashion Pattern 

Software or boxy style jacket 
pattern

• Computer with scanner
•  Fabric and notions according to 

pattern instructions plus extra 
fabric for larger facings

•  OESD LightWeight Tear-Away 
stabilizer

• 101 Quilt Basting Spray
•  Isacord Embroidery thread in 

charcoal (4174) or black (0020)
•  Black 60-weight cotton thread for 

embroidery bobbin
•  Size 75 Organ embroidery needles, 

regular or titanium
•  Approximately 50 charcoal or black 

pearl buttons in various sizes
•  Button Sew-On Foot #18

By SuSan FearS

 Squares & Circles 
Swing Jacket
 Squares & Circles 
Swing Jacket

BERNINA 830 Project
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Open embroidery design #SM28 from the 
830 Susanne Muller folder. The design 
can be obtained by reading from the 830 
into the software, or using the Backup 
Design CD. Use File > Insert Design to 
add the embroidery to the placement line 
files. If the design is too long for the area 
(has too many elements), ungroup the 
design and delete the extraneous parts 
of the design. If the design does not fill 
the area, ungroup and copy additional 
patterns or insert another design. Save 
the finished designs.

Use the View > Measure tool to 
determine placement of the design by 
accurately measuring the distance from 
the embroidery design to the seam line.

Create files for the Jacket Back, Jacket 
Front, Sleeve, and Collar. The files for the 
jacket front and sleeves will be mirrored 
to embroider the opposite sides.

For the collar embroidery, ungroup the 
design and place individual motifs on the 
collar, avoiding the seams. “Toss” the 
design randomly to create an interesting 
pattern even though the embroideries 
may only be one design deep.

Stitch Embroidery Designs
Check the hoop sizes – due to the width 
of the embroideries, plus the placement 
lines, the Jumbo hoop is required. Send 
the designs to the machine using the 
cable or save to a USB stick. Note: Be 
sure to update the V5 software with the 
patch to include the jumbo hoop files 
in the hoop choices. The patch can 
be found on the www.berninausa.com 
website under Support > Downloads.

Hoop tear-away stabilizer in the Jumbo 
hoop and stitch the placement line.

Remove the hoop and spray with 101 
Quilt Basting Spray. Lay the cutting 
line of the fabric on the embroidered 
placement line and smooth into position.

Engage the Basting Outline to further 
secure the fabric to the stabilizer if 
desired. Embroider all the edges and 
remove the excess stabilizer.

Construct Embellished Jacket
Redraw the cutting lines on the paper pattern so there is a 5/8" seam allowance instead 
of the traditional hem. Lay the pattern pieces on the embroidered fabric and re-cut the 
garment edges. Re-cutting after stitching the embroidery eliminates any fabric distortion 
caused by the embroidery.

Use the button-sew on foot to add 
charcoal pearl buttons in some of the 
open spaces in the embroidery. 

Be sure to place the buttons randomly 
to maintain the random pattern of the 
embroidery. 

Finish the garment edges using a 3-thread 
overlock on the serger. 

Assemble the jacket as directed by the My 
Label instructions; tack facings with a hand 
whipstitch if desired. Attach shoulder pads. 
Tip: If covering the shoulder pads to match 
the fabric, engage the BERNINA Dual Feed 
when stitching the fabric to the shoulder 
pads. 

creo
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Cutwork embroidery is reminiscent of days gone by, and very pretty in its traditional 
form of tone-on-tone embroidery. Those lucky to inherit cutwork linens have a piece of 
hand-sewn history and, perhaps, family history. New embroidery collections, such as 
the Heritage Creations Cutwork Collection #850, offer today’s machine embroiderer 
the same beautiful designs sewn with today’s technology. Change the color scheme to 
match a party theme or room design to create a contemporary statement.

The contemporary pillow collection that follows combines cutwork with embroidered 
letters or candlewick stitches with an updated color scheme. If vintage-style cutwork is 
more your style, just change the colors to tone-on-tone.

Creating the Cutwork Pillow Front 
Letter F Cutwork Pillow
Open the software and select File > New. Press “A” on  
the Keyboard to open the Lettering Tool and select the  
Erica alphabet. Type the letter of choice in the text box  
and press OK. Enlarge the letter 345% by dragging one  
of the corner sizing handles. 

Select File > Insert Design and select design #OC85035;  
position under the letter. Select both elements and center  
using the Align Centers Vertical tool. Click away to deselect. 

Creative CutworkBy SuSan FearS

Supplies
•  830 or 730E sewing  

and embroidery  
machine

•  Version 5 DesignerPlus 
Software

•  Heritage Creations  
Cutwork Collection 
#850

•  Hemstitched linen  
napkins, 12" x 12" 
(2 per pillow) from 
AllAboutBlanks.com

•  Isacord Embroidery 
Thread, top and bobbin

•  Organ 75S Embroidery 
needles

•  OESD BadgeMaster 
wash-away stabilizer

•  101 Quilt Basting Spray 
(temporary adhesive)

•  Double curved scissors 
•  ½ yard cotton fabric for 

each pillow form
•  Pillow stuffing
•  1/8" satin ribbon,  

approximately 20"  
per side

•  Tapestry needle
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Creative Cutwork

Select the cutwork design and click on Mirror Merge Vertical, then click when the second motif is above the 
letter. Click away to deselect both motifs. 

Select the first cutwork design again and use the quick clone tool to duplicate the design under the letter and 
drag to the right of the letter. Click 2 times on the rotate icon to rotate it 90°. While the motif is selected, select 
Mirror Merge Horizontal and click to place the motif on the opposite side.

Select Multi-Hooping and arrange the first hoop through the vertical center of the design. Rotate the second 
hoop and position it through the horizontal center of the design.

Save the design, then send it to the embroidery machine. Stitch the design.

Letter B Cutwork Pillow
Open a New file. Press “A” on the Keyboard to open the 
Lettering Tool; select the Secret Garden alphabet from 
the drop-down menu. Type the letter of choice in the text 
box and type 103mm in the height box; press OK. 

Select File > Insert Design and select design 
#OC85010; place to the lower right of the letter. 
Duplicate the cutwork motif, select Mirror Horizontal, 
and drag the motif to the opposite lower corner. Select 
both cutwork motifs and use Mirror-Merge Horizontal 
to place elements above the letter. 

Select one of the cutwork motifs; click on the rotate 
icon one time to rotate 45°. Drag so that the design is 

between the two patterns. Use Mirror-Merge Vertical to place one on the opposite side. 

Select all of the cutwork patterns and click on the Group icon. Select the cutwork group and the Letter, 
then click on Align Centers. 

Select Multi-Hooping and arrange the first hoop through the vertical center of the design. Rotate the 
second hoop and position it through the horizontal center of the design. 

Save the design, then send it to the embroidery machine. Stitch the design.

Floral Cutwork Pillow
Open a New file and open design #OC85004. 

Use the Rectangle tool to draw a box around the design using Outline > Candlewicking 
Border. The rectangle measures 118mm wide by 150mm high. Set the Candlewicking 
knot size to 4.5mm.

Select File > Insert Design and open design #OC85010; position at one corner. Select 
the design and right mouse click to quick clone the design for the other 3 corners. Use 
the rotate tool to frame corners of the candlewick rectangle.

Select Multi-Hooping and arrange the first two hoops over the design: one on the left 
and one on the right. 

Save the design, then send it to the embroidery machine. Stitch the design.

Sending the 
Design to the 
Machine Options
If the design is to be 
sewn in the 830 Jumbo 
Hoop then the entire  
file can be sent to the 
machine. For other  
embroidery machines, 
use the Multi-hoop  
option to split the design 
into two hoopings for the 
Large Oval hoop.  

Send to the machine 
directly or write to a 
USB stick to transfer the 
design for sewing.



Constructing the Pillow 
For the embroidery, hoop only the 
BadgeMaster wash-away stabilizer. Spray 
the stabilizer with temporary adhesive 
(or moisten the stabilizer) to hold the 
hemstitched napkin to the stabilizer. Center 
the napkin in the hoop by folding the 
napkin into fourths and placing the napkin 
center on the center of the stabilizer, then 
unfolding the napkin.

Smooth the napkin onto the stabilizer. 
Embroider the design, cutting out 
designated design areas and stitching the 
cover cutwork satin stitches and other 
effects. (Complete instructions for stitching 
cutwork are included with the embroidery collection.) Tip: Instructions are given in the Heritage Creations 
Cutwork Thread Chart for using Fiber Etch to dissolve fabric areas rather than cutting the fabric. Fiber Etch 
works only on natural fibers and the embroidery thread must be a synthetic, such as Isacord.

Wash away the stabilizer and let the 
pillow front dry. Press from the back to 
avoid glazing the Isacord. Tip: Press (also 
from the back) onto a terry cloth towel to 
cushion the embroidery and achieve a non-
puckered finish. 

Make a pillow form using fabric that matches the color of the 
napkin. Cut two 10.5" squares and sew around the edges, 
leaving a small opening in one side. Turn right side out and fill 
with stuffing. Use a whip-stitch to close the opening.

Thread the tapestry needle with coordinating or contrasting 
1/8" satin ribbon. Weave the ribbon through both napkins 
(one embellished and one plain napkin) placed wrong sides 
together. Join three sides of the pillow and insert the pillow 
form. Close the remaining side by again weaving the ribbon 
through the hemstitching. Tie the tails of the ribbon into bows 
at each corner and trim.

14
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Sweater #1 – Funky Fibers Weekend Fun

   SupplieS
   • 1 long-sleeved cardigan sweater
   • 2 skeins of funky yarn
   • Tiny buttons
   • Thread to match the sweater
   • Bernina seam ripper
   • Braiding Foot #21 or Clear Foot #34C for couching yarns
   • Button Sew-On Foot #18

DirectionS
Apply Yarns
Thread machine with matching thread in the needle and bobbin. 
Select the zigzag stitch, SW=3 and SL=3.

Unwind enough yarn from each skein to go around the part of the 
sweater you want to accent. For the sample sweater, the seamline 
along the inner neck and front edges was chosen, because it was 
able to support the weight of the couched fibers without puckering. 

Zigzag the fibers in place, leaving a 2" tail at the beginning and 
ending points. Tuck the tails to the wrong side, then straight stitch 
them in place to secure. Use the tip of your Bernina seam ripper 
to fluff up the couched yarns. 

Tiny Details Make All The Difference…
add visual interest by sprinkling tiny but-
tons onto the sweater to carry through 
the color story from the yarns. Select the 
button sew-on program and Button Sew-
On Foot #18 to quickly attach the buttons. 
This stitch on your Bernina automatically 
secures each set of left/right zigzags with 
tiny stitches. The rubberized toes of But-
ton Sew-On Foot #18 hold your button in 
place perfectly. Note: Tiny buttons may have a narrower distance 
between the drilled holes – try a test button and decrease the stitch 
width as needed so the stitches fall in the holes.

By nancy BeDnar

RETAIL 
RESTYLE

Got more dash that cash? Stroll through any 
shopping mall this season and you’ll see the 
season’s darling garment – sweaters! Beaded, 
embellished, buttoned and bowed, for casual, 
office or dressy occasions, sweaters are 
everywhere. And accompanying these soft pull-
ons are hefty price tags that could slow down 
even the most enthusiastic shopper. Fear not – all 
the looks you find in retail can be created with 
the help of your trusty BerninA, several clever 
presser feet, and some fun and funky notions, 
threads, and sparkles. each of these beauties 
begins with a plain, long-sleeved cardigan sweater 
purchased from a budget-minded garment store. 
BerninA helps you create a closetful of fashion-
current, fun, and fabulous new sweaters!

i s s u e  2 9
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Freemotion Couching Foot #43 is designed for use with smooth, flexible cords  
approximately 2mm in diameter, such as the Helios nylon cord used in this project.
 
Dense yarns with lots of body and “springiness” can often be used with this foot, 
but yarns that flatten as they pass through the guide and needle opening may not 
couch successfully. 
 
Loosely twisted and/or soft cords, such as knitting/crochet yarn, may not be  
suitable, as the needle may not penetrate the cord fully.
 
Always test cords and yarns before using on a project!
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Sweater #2 – Sparkling Fuschia Swirls
DirectionS
Apply Cord
install Freemotion 
Couching Foot #43 
on your machine. 
Thread the machine 
needle and bob-
bin with all-purpose 
thread. Select 
straight stitch (SL = 
2½). Check to be 
sure that the needle 
is in the correct posi-
tion to safely sew in 
the center of the lower hole in the Cording Foot.

Note: If the knit gauge of your sweater is lightweight, fuse a strip 
of knit interfacing to the wrong side where the stitching is desired 
to help support the weight of the stitching and cords.  randomly 
couch down the Helios cord. Begin and end at the center front of the 
sweater, leaving a tail at the beginning and the end. Turn the tails to 
the wrong side and straight stitch them in place.

Add the sparkle….
randomly apply Swarovski crystals around the corded stitching to 
add a glint of glamour!

   SupplieS
   • 1 cardigan sweater
   •  Helios nylon cord in variegated colors to coordinate 

with the sweater
   • all-purpose thread to coordinate with sweater
   • eZ Glitzer and Swarovski crystals
   • Freemotion Couching Foot #43

creo
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Sweater #3 – Evening Out In Lace and Ribbons
DirectionS
Create the Neckline Ruffle
install ruffler #86 on your machine. Set the ruffler to gather every 
stitch – the “1” setting. Select straight stitch (SL=2½).

Feed the ribbon so that one 
finished edge extends ¼" 
to the right of the needle. 
The ribbon must be placed 
between the two black lower 
prongs to correctly feed and 
pleat. Create enough ruffled 
ribbon to embellish your 
sweater.

Fluffy or tailored – the choice is yours. Before applying the rib-
bon ruffle to the neck edge, decide if you would like to create a 
crisp tailored edge or keep the soft gentle gathers. if the pleated, 
pressed look is desired, cover the ribbon with a press cloth to avoid 
accidently melting it with the heat of the iron.

Position the ruffled ribbon so that 
the ruffled edge is aligned with the 
neck binding inside seam. Using 
edgestitch Foot #10/10C, sew the 
ruffle to the neck edge, moving 
the needle position so that the 
stitching falls into the ditch of the 
binding seam. Fold under the rib-
bon edge at the beginning and end 
for a clean finish.

Lacy Additions…
readymade, glittering lace appliqués add instant glamour for 
pennies, enabling you to duplicate the romantic look of beautiful 
beaded sweaters from the 1940s. easily attach them using Leather 
roller Foot #55.

Pin the lace appliqués onto your sweater where desired. Set the 
machine for a narrow zigzag (SW and SL = 1½). install the Leather 
roller Foot #55 onto your machine. Move the needle position to 
rest as close to the roller wheel as possible.

Zigzag around the lace 
appliqués. Leather roller 
Foot #55 provides great 
maneuverability and visibility, 
allowing the multi-directional 
stitching to be completed 
easily.

Better Buttons…
instantly elevate the look of your sweater by changing the buttons. 
in this case, delicate pearl ball buttons were the perfect choice.

Even Better…
Continue the pearl accenting by applying Swarovski cream pearls 
using the eZ Glitzer.

   SupplieS
   • 1 cardigan sweater
   • Pearl buttons
   •  6 yards of sheer organza or satin ribbon – 1½" wide
   • eZ Glitzer
   •  4mm Swarovski Cream Pearls
   •  4 embellished lace appliqués
   • ruffler #86
   • Leather roller Foot #55
   • edgestitch Foot #10/10C
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By jo LeiCHte with contributions from Kaysie Oldani, Belinda Gibson, and Kristie Smith

Design Process
With so many choices, where does one start? Since i don’t often have many knits 
to choose from, i generally start my t-shirt design with the fabric.  Once i’ve decided 
on the fabric, i scan it into my computer so i can use it with My Label software when 
designing my shirt. after opening the software, selecting my model, and draping 

her in the t-shirt pattern, i “paint” the shirt 
pieces using my scanned fabric. right 
away i see how the shirt looks on my 
three-dimensional model, which is helpful 
as i determine whether i want long or short 
sleeves, jewel or scoop neck, flared or 
straight hem, etc. i also think about embel-
lishments while adjusting my pattern in My 
Label – will i be adding lace or buttons? 
Or just leaving it plain? i use the stitches 
pencil tool to draw on my pattern, adding 
lines for trim placement, a new neckline, or 
other enhancements to the pattern.

i always check the fit in My Label, turning the 3-D mannequin so i can see the shirt 
from all angles. i don’t like a tight fit, so i check the tension on the fabric using the 
Tension indicator. (red indicates areas where the fabric is closest to the body; 
blue shows the loose areas.) The original t-shirt is designed to have negative ease 

T-ShirtsStyles & Stitches
short sleeves, long sleeves, every 

length in between; straight, flared, 

plain, embellished. No matter how you 

style it, the humble T-shirt – 

a wardrobe staple – can be anything 

from a simple white cotton tee 

to an elegant embroidered designer 

knit. each one starts with the same 

basic style in BeRNiNA’s My Label 3-D 

Fashion Pattern software, the shirts on 

these pages show some of 

the variations possible with this 

simple garment shape.

T-Shirt descriptions, left to right
1.  T-shirt with lettuce-edges sleeves, hem, and 

neckline; made from cotton knit
2.  embroidered t-shirt with button embellishments 

and lettuce-edged sleeves; made from cotton knit
3. Long-sleeve t-shirt made from stretch lace
4.  T-shirt with ¾ length sleeves; made from onionskin
5.  Tunic tee with ribbed scoop neckline and lettuce-

edged sleeves and hem
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By jo LeiCHte with contributions from Kaysie Oldani, Belinda Gibson, and Kristie Smith

Styles & Stitches
through the hips, so i always add a few inches there so the fabric “skims” rather 
than “clings” in this area. 

Construction
My preferred method for stitching 
t-shirts is with a serger – they go 
together so quickly! i use a narrow 
three-thread overlock stitch for the 
seams, then hem the edges with 
a serger blindstitch or coverstitch, 
or just finish the edges with a 
narrow overlock or rolled hem. a 
decorative lettuce edge is easy 
to create by stretching the fabric 
while finishing the edge with a 
rolled hem. Depending on the 
fabric, an edge finish might not 

even be necessary – just trim the edges even with a pair of sharp shears or a wavy 
rotary cutter blade.

When stitching with a sewing machine, i use either a narrow zigzag stitch (length  
= 1, width = 1) or a vari-overlock for the seams, trimming the seam allowances to 
¼" before or after stitching. i use a stretchy stitch for the hems, usually a zigzag 

or jersey stitch. Check your sewing machine 
manual for additional options. 

if you’ve reshaped the neckline of your pat-
tern, you’ll need to adjust the length of your 
neckline ribbing. Measure the new neckline 
circumference and cut the ribbing 2/3 to ¾ of 
this measurement depending on how stretchy 
your ribbing fabric is. if unsure of the length, 
baste it in place and try on the shirt; you’ll be 
able to tell if it’s too loose or too tight. 

The chart on page 28 shows some of the op-
tions that have been used for the shirts shown 
on these pages.

For those with more “voluptuous” 
figures, or who simply want a more 
shaped t-shirt, the tunic pattern in 

My Label is easily adapted to t-shirt 
styling. the dart eliminates the extra 

fabric in the lower armscye, providing 
a better fit at the bustline. the tunic 
was designed for woven fabrics with 

no stretch, so adjust the ease as 
desired; you may want to reduce it 
to get a more fitted shirt, especially 

when using very stretchy knits. Leave 
the sleeves flared or reduce the cuff 

width for a straight sleeve. 
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BoDy 
DeSign

As is (very 
fitted through 
hips)

increase waist 
& hip slightly 
for a looser fit

increase 
waist & hip as 
desired for a 
flared fit

Shorten for a 
cropped top 
or lengthen for 
tunic or dress

neckline  
DeSign

As is (jewel) increase neck 
base for larger 
opening

Scoop or 
V (draw in 
software using 
stitch tool, or 
trace from ex-
isting garment)

SleeVe 
DeSign

as is, short or 
long

Adjust length 
for ¾ sleeve

Adjust cuff 
measurement 
for more or 
less flare

SeamS Serger 
3-thread over-
lock (fastest)

Sewing  
machine zig-
zag, then trim

trim, then 
seam with 
sewing 
machine 
overlock stitch

HeMs & 
neckline 
FinisHes

Plain serged 
edge

Rolled edge 
(stretch and/or 
increase differ-
ential feed for 
lettuce edge)

Apply ribbing 
or band

Apply trim 
(stretch lace, 
foldover braid, 
etc.)

turn under & 
coverstitch

turn under & 
machine-stitch 
(zigzag, jersey, 
overlock)
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T-Shirt descriptions, left to right
1. Tunic t-shirt
2. Short-sleeve t-shirt with lace trim; made from silk knit
3. Short-sleeve t-shirt made from silk jersey
4.  embroidered long-sleeve t-shirt lengthened to dress length; made from cotton knit with  

gathered fabric ruffle inserted between neckline ribbing and dress

t-shirt Design options

creo
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Create the Design
Open Bernina DesignerPlus V5 Software.

right click on the Show Hoop icon; the Hoop dialog box will open. From the hoop drop 
down box, choose artista 255 X 145 Oval. if necessary, left click on the Display Hoops box 
until a check appears. Click OK. 

Left click on the Monogramming icon; the Monogram dialog box will open. Under the 
lettering tab, left click on initials and enter 3 initials into the boxes with the initial for the last 
name in the center box. Note: Names can 
also be monogrammed. Letters should be 
visible. Left click on the Show All Mono-
gram icon at the bottom of the dialog box to 
see the total design.

Left click on the drop down arrow beside 
alphabet to choose a font. The erica font was 
used for the sample. DesignerPlus provides 
65 fonts plus all of the true type fonts found 
on your computer.

Supplies
• Cloth diaper
•  Bernina® Sewing/embroidery machine
•  Bernina® DesignerPlus V5 Software
• Organ embroidery needles
• isacord threads
• OeSD aquaMesh Wash-away Stabilizer
•  101 Quilt Basting Spray
•  Large Oval Hoop (artista 255 X 145 Oval)
•  ribbon (length = width of diaper + ½")
•  Teardrop embroidery Foot #26
•  edgestitch Foot #10/10C
•  #80 Universal needle
•  Mettler Metrosene Plus thread to match 

ribbon
• White thread to match diaper

BaBy Cloth
By kRistie sMitH

Cutsie Oopsie

creating a 

personalized baby cloth 

is easy with BeRninA 

Version 5 software. 

transform a simple cloth 

diaper quickly and 

easily for a special little 

someone with a little help 

from BeRninA.
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Left click on the drop 
down arrow beside color 
and choose C3 (red).

Left click on the style 
icon and hold; scroll 
with the curser and se-
lect style 5 (monogram 
with enlarged center 
initial). 

Left click on the Border 
tab. Left click on add  
to add a border; a  
dialog box will open. 
From the borders menu, 
select KB8 (flower). 
Select OK.

Left click on the Show 
All icon to display the 

entire design. Left click on the drop down arrow beside Color; select 
C4 (yellow). 

Left click on add again to add another border. With the second 
border highlighted, left click on the drop down arrow beside color; 
select C16 (pink).

Left click on border 1 to highlight; left click on fill; Border 1 will 
become a step fill.

Left click on the arrow  
beside the fill icon and 
select candlewicking fill.

Left click on View Prop-
erties and the object 
properties box will open. 
Within the box make the 
following changes: Col-
umn Spacing to 9mm, 
row Spacing to 9mm, 
row Offset to 4.5mm, 
and rotation angle to 
45 degrees. Select apply 
and OK.

Select OK again to 
close the monogram-
ming menu. Left click 
on the design to Select 
All. Left or right click as 
needed on the Scale 
by 20% down/up icon 
to scale the design to fit 
within the hoop.

Left click on the  
Arrange menu and 
select Pattern Stamp.

From the Monogram 
Ornaments menu, 
select Moo3a. Click OK. 
Design will be attached 
to the cursor. 

Place first design and 
left click to set in place. 
repeat 3 more times. 
Touch the eSC key to 
deselect the tool.

Save the design as 
monoflor and send the 
design to the machine.

Stitch the  
Embroidery
adhere two layers of 
aquaMesh to the back 
of the diaper with 101 Quilt Basting Spray. if stitching on a loosely 
woven fabric or a fabric with nap, add aquaFilm stabilizer to the  
top of the fabric. Both stabilizers are water-soluble and will be 
removed after stitching is complete. Hoop the fabric and the layers 
of stabilizer in the large oval hoop.

Open design on the  
embroidery machine,  
insert an Organ needle 
for embroidery, and 
thread with isacord 
color of choice. Place 
the hoop on the  
machine and position 
the design as appropri-
ate. Start the embroi-
dery machine and 
complete the design.

remove excess  
stabilizer from around 
the design by cutting 
away with scissors. 
remove the rest of the 
stabilizer by running 
water through the embroidery in a sink or tub. Let fabric dry. 

apply Ribbon 
insert a #80 Universal needle, thread ma-
chine with Mettler Metrosene Plus thread, 
and attach edgestitch Foot #10/10C to 
the machine. Select a straight stitch; move 
needle position to the left 3 notches. Press 
under ¼" at each raw end of the ribbon. 
Position ribbon on the lower edge of the 
diaper. With the guide of the foot at the 
edge of the ribbon, edgestitch to secure 
the ribbon to the diaper. your favorite baby will love this personalized 
creation!
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Purple Pizzazz
Materials
•  Faux leather in purple 

and white
•  Mettler Cordonnet 

thread in white
•  Mettler Metrosene Plus 

thread in purple
•  Topstitching needle 

size 90 for Cordonnet
•  Universal needle size 

80 for Metrosene Plus
•  Wonder Tape
•  Cardboard or template 

plastic
•  Walking Foot #50 or 

Non-Stick Foot #52
•  2 eyelets per holder, 

diameter = ½" (11cm) 
(Hanging Gadget 
Holder only)

•  Wire cable (Hanging 
Gadget Holder only)

•  Silver wire (Pen 
Monster only)

•  Felt remnants in 
black and white (Pen 
Monster only)

How best to remember what needs to be done before leaving 

the house in the morning? Where should you stow those bits 

and pieces that accumulate in the hallway, bathroom or office? 

We’re all faced with these questions, and we’ve injected a bit of 

purple cheer into these solutions.

Pen Monster
Made in no time flat, our pen monster also makes a clever little gift. 

CUTTiNG DireCTioNS 
- Cut two rectangles from faux leather, each 1¼" x 3¼" (3cm x 8cm)

iNSTrUCTioNS
Wrap wire for the “hairdo” several times around two fingers. Draw a curve at one short 
end of each fabric rectangle. Place wrong sides together and insert wire between 
the two upper edges; secure with Wonder Tape. Stitch layers together along the 
long edges and curved line. Cut away excess fabric along curved end. Bend hair into 
shape. 

Cut ovals for eyes from black and white felt. Arrange as desired and stitch to the edge 
of the Pen Monster using the pre-programmed button sew-on stitch (or a universal 
stitch with length = 0mm). 
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Door Organizer
Memory like a sieve? A note to yourself on the front door, a pocket 
for stowing those letters to be posted – this door organizer will have 
you sorted in no time flat! The faux leather is a breeze to sew with 
Walking Foot #50, BERNINA Dual Feed, or Non-Stick Foot #52, 
and the heavy-duty Mettler Cordonnet thread lends a professional 
touch to your project.

CUTTiNG DireCTioNS
- Cut two back panels from faux leather, each 5¾" x 13¾" (15cm x 35cm) 
- Cut one piece cardboard or template plastic, 5½" x 13½" (14cm x 34cm)
- Cut one pocket from faux leather, 5¾" x 77/8" (15cm x 20cm)
- Cut one pocket from faux leather, 5¾" x 5¾" (15cm x 15cm)
- Cut one pen holder, 31/8" x 31/8" (8cm x 8cm)

iNSTrUCTioNS
Cut a 41/8" x 2½" (10.5cm x 6.5cm) rectangle in the cardboard or template plastic 
rectangle, 1¼" (3cm) from the top edge. Place card between back panels; affix 
with Wonder Tape. Stitch around opening, close to cut edges. Cut a 37/8" x 23/8" 
(10cm x 6cm) hole in the faux leather; stitch along all edges of opening. 

Hem upper and lower edges of pen holder. Trim corners of seam allowances on 
the diagonal. Pin to back panel.

Hem top edge of each pocket. Affix pockets to back panel with Wonder Tape; 
edgestitch along sides and lower edge. Trim sides even if necessary.

Purple Pizzazz

Hanging Gadget Holder
Any number of gadget holders can be suspended from some 
wire cable to create an original organizer.

CUTTiNG DireCTioNS (for one holder)
- Cut two back panels from faux leather, each 6¼" x 6¼" (16cm x 16cm) 

- Cut one piece cardboard or template plastic, 6" x 6" (15cm x 15cm)
-  Cut one pocket from faux leather, 77/8" wide by 97/8" tall (20cm wide  

by 25cm tall) 
-  Cut one decorative arrow from faux leather, 2¾" long and 13/8" 

wide (7cm long and 3.5cm wide)

iNSTrUCTioNS
Attach arrow to pocket with Wonder Tape, approximately 1¼" (3cm) 
from what will later be the top edge; stitch in place. Fold pocket in 
half; topstitch ¼" from upper folded edge. 

Place cardboard or template 
plastic square between the 
two back panels; affix layers 
with Wonder Tape. Stitch 
together along all four edges.

Stitch a ¾" (2cm) deep base 
at the lower edge of the 
pocket, stitching across the 

corners of the base on the right and left, beginning each seam approxi-
mately 1/8" (2mm) from the raw edges and ending at the fold. Trim corners.

Stitch pocket to back panel; finished height is 4¾" (12cm). Trim sides even if necessary.

Insert eyelets at upper corners following manufacturer’s directions.

This project was originally published by BERNINA International in Inspiration magazine, No. 42, Autumn-Winter 2008.
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To Pull a Shingle of Roving
Note: Roving is unspun fiber. It comes from a variety of sources: plant, 
animal and synthetic. Merino wool roving is ideal for this technique. 
Assortments are available from www.fiberella.com. Designate one hand 
for holding-the-roving or the stationary hand. Use your fingers and thumb 
on the opposite hand for pulling the “shingles”. (Generally my left hand 
is stationary and I pluck the wisps of roving or shingles with my right). 
Shingles can be overlaid, one over another or placed side-by-side in 
machine felting.

Get a Gentle Grip
Just ever-so-gently hold roving about 3" from its end. Keep your grip loose 
enough to allow roving shingles to slide out with ease, yet firm enough 
to control the length of the shingles. You can adjust this length for your 
project as desired.

BY PAulA ScAffIdI

The Fold-Over…
A Felting Technique from Fiberella

Enjoy a thin but delicious slice from 

Paula Scaffidi’s upcoming book, a 

2009 release, by making an elegant 

shawl featuring colorful needlepunch 

wool fibers. Learn how to “pull a 

shingle’ of roving and attach to a 

base fabric with Paula’s guidance 

and how-to photos. Like all of 

Paula’s roving, yarn and fine fabric 

techniques… you’ll find it simple, 

lush and beautiful.
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The Fold-Over…
A Felting Technique from Fiberella

Select a desired Width
The width of the roving shingle is controlled by your fingers on the 
other hand. Using only the very tip of any one finger against the tip of 
your thumb, you can pull the tiniest of shingles. Try using the entire 
fingerprint area from a finger and thumb to pluck a shingle about ½" 
wide. A pointer and a pinky will give you two different sizes. Adjust as 
desired. 

coloring
it’s relaxing and pleasurable to place a bit of one color of roving over 
another for endless color blending. If you simply vary the ratio - more 
of one color and a narrow streak of another - you can create a 
variegated effect. You can also pull multi-colored shingles in your own 
color combination. Lay two or more roving colors together and gently 
grasp some of each color. Then pluck as if one roving, pulling a bit of 
all colors simultaneously.

Shingles want to shrink as you felt them; let them! I prefer 
using a hoop when a flat base is desired; it assures a smooth 
base and eliminates any fatigue on shoulders and hands.

Try a Warm up… Line Becomes an Edge
Lay out some roving 
shingles side-by-side on 
a base fabric. Visualize 
the path of your line 
as perpendicular or 
opposite to the length 
of the shingle. Machine 
felt any type of line.* 
The key: fast motor 
speed and slow fabric 
movement. I’ve used 
silk noil here for an 
elegant yet somewhat 
casual effect - worthy 
of a special occasion 
but with an earthy feel. 
Plus it holds up well to 
the action of the felting 
needles. 

Make sure you can see your line through the shingles!

 *A thought, impulse or feeling… There’s 
satisfaction in creating a line based on your 

mood. Are you feeling: fanciful, wavy, or wiggly; 
curvy or jagged; very relaxed or full of bold 

excitement? Get the feel of moving your fabric 
in sync with today’s personal rhythm. Maybe 
try alternating smooth curves with straight 

lines. A swinging or swaying line has a different 
expressive feeling than one that tap dances 

in a zigzag repeat pattern. Water has ripples 
dependent on the wind. Grasses bend. What 

lines will you make today? 
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Take a peek. “Fold Over” the roving at the felted line using 
your hand. Gently move it to one side and then the other. 
What looks more exciting to your eye? Beginning at the fold, 
felt the roving down. Work gradually to the feathered edge 
of the shingle, allowing the roving to shrink its way toward 
the needles.

Pick a Shape Any Shape…. 
Beautiful shapes are all around us. In nature, as you study 
a shape there are “lost and found” edges; those we easily 
see and those that seem to melt away, disappearing into the 
background. Squint to see this effect more easily. 

Begin by finding a pleasing shape to use as your design 
inspiration - a vase, a decorative pin, a floral or leaf shape, 
the lovely empty space noted between two balusters on a 
balcony. It can be anything that appeals to you. Geometric 
or organic, I enjoy using any simple shape with this 
technique. Shapes larger than 4" across give my fingers 
room to work. I pull shingles that are short enough to fold 
over, felt down, and still see the opposite edge of the shape. 

Shawls for Inspiration
i’ve placed the roving shingles “on grain” with the base 
fabric in the elegant evening shawls shown in this article. To 
my eye, the horizontal, on-grain placement lends a serenity 
and unity to the designs*. By folding over roving shingles to 
both the inside and the outside of the circles; and skipping 
some edges along the way, the edge effect is “lost and 
found.” In the final design, the background fabric and motif 
shapes advance and recede alternately. It’s a kind of hide-
and-seek played with shapes. You simply chalk the shapes 
and work them one at a time, hooping as you go.

Shawl Measurements
Base Fabric or Shawl Blank: I used silk noil approximately 
21" x 90" in length. Circles to Trace: mine happened to 
measure 3.5", 4.5" and 6.25" in diameter.

Motif Placement: In Heavenly Bodies, the circles are 
staggered over approximately one third of the length of the 
shawl. The shawl blank is adequate in length for most and 
of course can be shortened as desired according to height. 
My recommendation is to keep the length until you try it on 
in the final phases. Then shorten the non-embellished end 
as desired.

Sometimes I use a toothbrush to control the direction and 
smooth the roving into the look of a felted “brushstroke”. 

If you wish to distribute the roving on both sides of the already 
felted line, use an awl to help split it. Then brush and felt it down.

Trace cups, bowls and plates for circles that vary in size.

*If you were to position the roving 
perpendicular to your line all the way around 
the shape, the effect would be an explosion 

or implosion… a dynamic way to 
create another mood.
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Mini Project Idea… A Simple Start
Either of these approaches would make a great little pillow project. It’s all in how you “crop” 
your image. It’s fun to literally “pull colors together” from your room décor. Gather up roving 
in a matching palette and don’t be afraid to throw in a surprise color as an accent. 

An All-Over design
A small pillow project would be a great size to experiment with this technique. An old axiom 
in art is to “fill a space with a repeating design motif that appears to go off the edge or travel 
beyond the ‘canvas’ (or desired fabric panel) on two or more edges.” This going-off-the-
edges effect strengthens composition in design. 

A Single Motif
You can also opt to feature a single motif in the center of your panel. I suggest making it 
large enough to visually dominate the remaining, empty background space.  EnJOY!

You can use plastic plates plus a flex curve to transform the circles into 
biomorphic shapes. Note: The metallic texture used sparingly in both shawls  
is a fabric technique, also included in Paula’s upcoming book.

A pioneer in the field of machine needle felting, Paula Scaffidi is both an artist and a teacher. She is experienced in a wide 
range of media and draws inspiration from the natural world and the imagination. Exploring creative possibilities, Paula 
enjoys developing fresh textile techniques. With dual degrees in art and art education, she teaches nationally and offers 
creative textile retreats in North Carolina. A contributor to Lark’s Designer Needle Felting, Paula has also published articles in 
several countries.  Her own book will be released in 2009. To learn more about Paula’s art, go to www.fiberella.com.

All That jAzZ Heavenly Bodies
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At the Computer
Select File and New or click on the New icon. Right click on Show Hoop. 
From the list of available hoops, select artista 255 X 145 Oval. Click on 
OK to confirm the hoop choice and close Options.

Position the Wine Wrap blank on the bed of the scanner with the long side 
of the blank at the top of the scanner and the center point going down. 
Select the Picture View and click on Scan Picture. Following your scanner’s 
instructions, scan the picture. When the scan is complete, the scanner 
software will close and the picture will be displayed on the Picture View 
screen. With the picture still selected, save the picture as wine wrap.BMP. 

if the grid is not displayed, left click on 
Show Grid to display the grid. With the 
picture selected, center the lower point of 
the wrap on a grid line.

Change to Design View. Select the Open 
Object tool. On the Stitch and Color bar, 
select Outline > Single. Change the color to C7. Beginning on the left side of 
the hoop and using 3 left mouse clicks, create a placement line just outside the 
scalloped edge of the wrap. Touch Enter to confirm the line’s placement.

Select File and Insert Design. Locate Local disk C > My Designs > Laces.  
Locate and Open NX245. Center the design between the scalloped edges.

Select File and Save as. Name the design Tassels and Lace 1 and Save.

Select the Open Object tool. From the Stitch and Color bar, select Outline. From the list of available outline types, 
select Satin and C2. Left mouse click just within the left side of the lower center satin-stitched loop. Move the mouse 
to the right until it rests just inside the right edge of the same center satin stitched loop. Left click again. Touch Enter 

to complete the line.

Click on the Select Object tool. The satin line should be 
selected. If Auto Underlay is active, left click to turn it off. 
With the blue satin line still selected, left click on the Object Properties icon to open 
Object Properties. If not already selected, select the Outline tab. Left click in the 
Manual box; change Stitch Spacing to .30 mm; change Stitch Width to 30 mm. 
Select Apply and OK to confirm the new settings and close Object Properties.

Select File and Save as. Name the design Tassels and Lace 2 and Save.

right click and drag the center tassel, creating a 
clone. Position the cloned tassel below the right filled 
circle. Deselect.

right click and drag the center tassel, creating 
another clone. Position the third tassel below the left 
filled circle. Deselect.
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BY PAT JENNINGS

Tassels and Lace 
   Wine Wrap

Supplies
• BERNINA DesignerPlus Embroidery Software
• BERNINA Sewing and Embroidery Machine
• Computer with scanner
• Large Oval Hoop
• Wine Wrap Blank from AllAboutBlanks.com
• OESD AquaMesh Plus – 10" X 14"
• Isacord embroidery thread – any color
•  Mettler 60 weight Embroidery thread – white  

for the bobbin
•  Size 80/12 Organ Embroidery needles
•  Small, sharp embroidery scissors
• Embroidery Wand
• Steam iron
• Thick terry towel
• Best Press non-aerosol spray starch

Here’s a quick and easy way to dress up a wine bottle 
for your next festive affair.
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Select the left tassel and shorten it to 
75%. Repeat for the right tassel.

Select the left and right tassel; from 
the Arrange bar, click on Align Bot-
tom (Horizontal). Deselect.

if Color Film is not displayed, select 
Arrange > Color film to display Color 
Film on the right side of the screen. 
Select the red color chip (C1) and 
click on Sequence to End. 

Select File and Save As. Name the file 
Tassels and Lace 3 and Save.

Select the center tassel. Click on 
Reshape Object. Move the green 
Start symbol to the upper left corner 
of the tassel.

Move the red end symbol to the 
lower right corner of the tassel. 

Touch the Enter Key on the keyboard to confirm the change.

Repeat these changes for the other two tassels. Touch ESC on the 
keyboard to turn off the tool.

Select the center tassel and open Object Properties > Tie-In/Tie 
Off tab. Turn off Tie Off After Object and Apply to confirm changes. 
Repeat for the other 2 tassels, clicking on Apply before selecting 
the next tassel. Select OK to close Object Properties.

Select File and Save As. Name the design Tassels and Lace 4 and 
Save.

Select the Zoom Box tool and click and drag a bounding box around 
the tassels to zoom in on that area of the design. Select View and 
Slow Redraw. Move the sliding speed control to the left to slow down 
the process. Click on the Green go arrow to see how the design will 
stitch before transferring the design to the Embroidery machine.

Touch the ESC key twice to turn off all tools. Change to Picture 
View. Select the picture and touch the Delete key on the keyboard. 
Return to Design view.

Select file and Save As. Name the design Tassels and Lace 5 and 
Save. Transfer the design to your embroidery machine for stitching.

At the Embroidery System
Hoop the OESD AquaMesh Plus (paper side up) in the Large Oval 
Hoop. Position the hoop on the 
embroidery arm and stitch the first 
color (the placement line).

When the machine stops, remove 
the embroidery hoop from the em-
broidery arm but do not remove the 
stabilizer from the hoop.

Using the sharp point of the em-
broidery wand, score the stabi-
lizer’s paper covering above the 
stitching line and around the edge 
of the hoop above the stitching 
line. Remove the paper, exposing 
the sticky surface of the oeSD 
AquaMesh Plus stabilizer.

Position the wrong side of the Wine 
Wrap against the sticky side of the 
OESD AquaMesh Plus, aligning the 
sides and point of the wrap with the 
stitched placement line. Smooth the 
wrap onto the stabilizer.

Return the hoop to the embroidery arm. 
Lower the presser foot and stitch 
the remaining areas of the design. 
Note: it is not necessary to 
change thread colors. The place-
ment line and the embroidery 
design may be stitched with  
the same color. As the design 
stitches, it is a good idea to clip 
jump stitches within the lace  
section of the design before they become trapped under the  
designs stitches. Stop the machine, lift the presser foot, trim the 
jump stitch, lower the presser foot, and press the Start/Stop button 
on the head frame to continue with the design.

When the design is complete, 
remove the hoop from the embroi-
dery machine and remove the 
stabilizer/wrap from the hoop. 
From the back (wrong) side of the 
project, clip the long white tassel 
threads at the bottom and top of 
the tassel.

From the right 
side, gently 
pull the tassel 
threads to the 
surface to com-
plete the tassel.

Carefully peel 
back and 
remove the 
excess stabilizer. 
Gently rinse the 
project in warm, 
running water to remove the remaining stabilizer. Wrap the project 
in a heavy terry towel to remove as much water as possible. With 
your fingers smooth the tassel threads into place. Air dry. When dry, 
position the wrap on a dry terry towel with the design face down 
and the tassels in the correct position. Gently press the project to 
remove any wrinkles. A spritz of Best Press as you press the proj-
ect will give the wrap a little extra body.
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Top Cover 
When embroidering on towels 
and other textured fabric it 
is important to use a top-
ping to prevent the nap from 
popping up through the 
stitches. However, there are 
times when even the best 
water-soluble topping may 

still allow the color of the background 
fabric to show through the stitches. A case in point is 

the example of the snowman stitched onto the dark fabric. Many 
times we are tempted to simply re-stitch the white area again. This 
will create additional bulk, and can cause outlines to be off. It also 
increases the chances of needle breakage.

A new embroidery product 
from oeSD will help solve 
this problem. This product 
will improve the look of 
your embroidery design 
when stitching a light-
colored design on a dark 
fabric, or vice versa – 
stitching a design with 
black or dark thread 
colors onto a light-
colored background. 
Top Cover is a perma-
nent vinyl-like product that will remain 
inside the stitching and keep the design looking good 
for years to come. Note the difference in the picture of the Snow-
man using TopCover and the picture of the Snowman without 
using the Top Cover.

To use Top Cover:
1)  Simply place a piece of Top Cover over the area to be embroi-

dered. There is no need to hoop the product. 
2) Stitch as usual. 
3)  When the design has finished stitching, gently tear the excess 

away. 

This product works best when using fill stitching with hard edges. 
Tiny bits can be removed by placing a paper towel over the de-
sign and pressing. The heat from the iron will usually melt away 
the tiny bits.

Gentle 
Touch
Gentle Touch was created to cover the bobbin 
stitches on a project and is applied after the design 
has completely stitched. The needle thread on 
a well-balanced embroidery stitch should pull to 
the underside slightly. This thread can be slightly 
abrasive to babies or others with sensitive skin, 
especially if you are using a metallic thread in the 
needle. 

To use Gentle Touch:
1)  Cut a square or rectangle 

rounded corners slightly larger 
than the design. 

2)  Place the fusible side of 
this piece over the bobbin 
stitches on the underside of 
the project or garment.

3)  Cover with a press cloth 
and press permanently 
into place with an iron. The 
photo shows how the Gentle Touch  
covers the stitching on the lower two designs  
and will protect the skin.

Fuse & Fleece
This lightweight fusible fleece is designed to be used 
wherever a lightweight fleece product is desired. It 
can be used in craft projects, as well as garments. It 
is available on a 10" roll, but can be easily pieced if 
wider widths are desired.

To use Fuse & Fleece:
1)  Position the fusible side of the fleece on the 

wrong side of the fabric. 
2)  From the right side of the fabric, lightly steam  

into place for a temporary bond, or steam more 
heavily for a more permanent bond. 

Improving Your Embroidery with 
         New Embroidery Products 
from OESD BY KAy HIcKMAN

OESD recently updated its product 
line and added several 

exciting products. Find out 
what’s new and how 
these products will help improve your embroidery.

creo




Improving Your Embroidery with 
         New Embroidery Products 
from OESD

Fuse & Fleece is washable and dry cleanable. PLEASE NOTE: 
The fabric must be able to withstand temperatures necessary for 
steaming. Always test on a scrap or on an inconspicuous place 
first.

Applique Fix ‘n’ Fuse
This product is designed to make 
appliqué easier – whether used 
for traditional hand or machine 
appliqué, or for machine em-
broidery appliqué designs.

This product has fusible coat-
ing on one side and a paper-
backed adhesive surface 
on the other. The adhesive 
coating can be stitched through and will 
not gum up the needle. The adhesive coating is light enough that 
it leaves the appliqué feeling soft.

To use Appliqué Fuse & Fix for machine embroidery  
appliqué designs: 
1)  Print the paper template of the appliqué portion of the design 

using Explorations Embroidery Software or BERNINA Embroi-
dery Software. Trim the pattern roughly leaving approximately 
½" paper on all sides of the pattern.

2)  Cut a piece of Appliqué Fuse & Fix slightly larger than the 
pattern and place the fusible coating on the wrong side of the 
appliqué fabric. Adhere into place by placing the iron (on cot-
ton setting) in one place for 5 seconds, then lifting and moving 
to another area of the appliqué if necessary. 

3)  Place the wrong side of the pattern 
from Step 1 against the right side 
of the fabric. If desired, you may 
adhere the pattern by lightly spray-
ing the back of the paper with a 
temporary spray adhesive such as 
101 Quilt Basting Spray.
4)  Cut out the shape following the 

pattern outline.
5)  remove the paper template 

from the front of the fabric.
6)  Carefully remove the release paper from the back of the cut-

out appliqué shape revealing the adhesive surface. 
7)  Stitch the embroidery place-

ment line onto the fabric.
8)  Place the shape inside 

the guide stitches and 
finger press into place. 

The Appliqué Fuse & Fix may 
be repositioned several times if 
necessary.

9) Appliqué Fuse & Fix 
may also be used when 
doing appliqué by hand 
or machine. Follow steps 
2 through 6, and then 
finish the edges by hand 
or machine.

AquaTear™

AquaTear™ is the long awaited 
biodegradable water-soluble tear-away stabilizer. 
This stabilizer combines the sturdiness of a tear-
away stabilizer with the easy-removal properties of 
a wash-away stabilizer. The biodegradable aspect 
makes it ecologically-friendly. It washes away al-
most entirely after the first washing and completely 
with subsequent washings. The biodegradable 
fibers in this stabilizer make the product great for 
woven fabrics such as kitchen and bath towels or 
garments where excess stabilizer is not desirable.

MediumWeight Cut-Away
OESD MediumWeight Cut-Away 
Stabilizer is new to oeSD’s line of 
stabilizers. It is lighter in weight than OESD Heavy-
Weight Stabilizer, but heavier the oeSD’s Poly 
Mesh Stabilizer. It can used for knit fabrics or for 
wovens where more durability is needed for higher 
stitch count designs. Cut away excess stabilizer 
after the embroidery process is complete.

HeavyWeight Tear-Away
By popular consumer demand, 
HeavyWeight Tear-Away has been 
added to OESD’s stabilizer line-up. 
This tear-away stabilizer has a stiffer 
and heavier hand than the current 

line of tear-away stabilizers. It will support a larger 
number of stitches and provide an excellent  
stitchout. Gently tear away excess stabilizer after 
the embroidery process has been completed.
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KAY HICKMAN
As the Product Development Manager at 
OESD, Inc., Kay’s job is to assist in the 
development of designs and embroidery 
cards for BERNINA® and oeSD, and 
to create projects using the embroidery 
designs. She has a BS degree in Home 
economics education from oklahoma 
State University.
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www.berninausa.com

www.berninabsr.com

www.berninaUSAblog.com

www.berninaMyLabel.com

www.bernina8series.com

WEB&BLOGNews
Log on and see 

what’s new at 

www.berninausa.com
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Log on, take a tour, and see a free show. 

You’ll also find free  BERNINA educational videos detailing 
the use of BERNINA presser feet and  accessories.

Alex Anderson ricky Tims

Get the scoop on the latest addition to the BERNINA family. There’s  
nothing like the BERNINA 830. Get an overview of this amazing machine  
and while you’re there get Free directions for an embellished tote  
made on the 830. Go to: 
For Information: Products > Sewing & Quilting > BERNINA 830
For Tote Bag Directions: Make It > Projects > 830 Tote

NEW - V.5 Embroidery software Service Pack 2 is 
available! This adds support for the Vista 64 bit  
operating system as well as the ability to  
communicate with the new 830.  
Go to:  Support > Downloads

New Projects! Check to BERNINA web site  
frequently to download FREE projects. The latest  
are Pheasant run Denim Skirt, reversible  
Bibs, Denim Delights, and Eyelet  
capris. Go to:   
Make It > Projects > Project title

bernina blog
www.berninaUSAblog.com is a year old! Many thanks to all our 
readers – over 30,000 of you visited our blog during the first 
year! Some of the high points were Gayle Hillert’s weekly blogs 
during the new BERNINA 830 introduction, sewing tips from 
Erika and Jo, and Martin Favre’s movie debut in 008: The Red 
Case Caper (if you missed it, check out the August 11 archive). 
We’re looking forward to another great year in 2009!
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A journal cover is the perfect palette to create a custom cover that expresses the style, creativity 
and interests of the author of the pages within. This project provides the opportunity to experiment 
with new techniques. Create one for yourself as well as one to give away! What better way to keep 
track of all those tips, techniques and great ideas for machine embroidery?

Reverse appliqué was used to create this signature journal cover. In this technique the fabric is 
layered behind the main fabric, which is cut away to expose the hidden layers. It is fun and creates 
an element of surprise; the surprise is how easy it is to master the technique!

Create the Embroidery and Appliqué
Create a fun reverse appliqué design using one of the fonts from BERNINA® V5 Software. Select 
File and Open. Right click on Show Hoop; select artista 255 x 145 oval from the list of available 
hoops. Be sure Display Hoop is checked. Click OK, then click on Show Grid to display grid.
 
Right click on the Lettering / Fill Values Tool. Click on the drop-down arrow beside Alphabet, select 
Drifter, then type an upper case E. Click on Apply, then click on the screen to see the letter. Select 
Show 1:1. Change the letter height: Select the letter E, select the corner sizing handle bars, and 
increase the size by 700%. Click on Apply. Touch ESC to deselect.

Select Show All. Select the Closed Object tool and select Outline and Triple Stitch. Select C9 dark 
red from the color palette. Starting at the top of the E with a series of left and right mouse clicks, set 
reference points to trace the outline of the letter. Touch Enter to digitize the shape. 

In Color Film, click on the first color to select the filled stitches of the letter, then touch the Delete 
key. Select the Triple Outline stitch. Select Object Properties > Outline Stitch tab, then change the 
stitch length to 3mm and click OK. Touch ESC to deselect.

Right click on the Lettering/Fill Values Tool, then type lower case mbroidery. Select Apply, then 
click on the screen one grid square to the right of the lower curve of the letter E. With mbroidery 

selected, select C2 Blue from the color palette. Touch ESC to 
deselect.

Select the Rectangle tool. Select Outline > Pattern 
Run. Select C2 red from the color palette. Draw a 

rectangle around E mbroidery, 1 grid square 
from the outside of E mbroidery design. Left 
click to position. Select Pattern Run Outline 

and open Object Properties > Pattern Set. 
Select Pattern > Home Dec > Stitch #402 and 

click OK. Click Apply and OK. 

Supplies
•  BERNINA® Sewing and  

Embroidery System 

•  Large Oval Hoop 
(255x145mm)

•  BERNINA® Embroidery Software 
(V5 Editor Plus or higher)

•  1/3 yard mid- to heavy-weight 
fabric (denim or similar; if you 
choose a lighter weight, use 
lightweight fusible interfacing to 
add body to the fabric.)

•  6” square of fabric for appliqué 

•  OESD HeavyWeight Cut-Away

•  Freezer paper to create a  
pattern for the cover

•  2/3 yard 3/8" ribbon (optional – 
for bookmark)

•  #80 Sharp Organ needles for 
embroidery

•  #80 Jeans needle for  
construction

•  Isacord embroidery thread

•  Superior Bottom Line bobbin 
thread to match fabric

•  Mettler thread to match fabric 
for construction

•  101 Quilt Basting Spray
•  Nifty Notions appliqué scissors
•  Nifty Notions curved  

embroidery scissors 
•  Nifty Notions 7" X 24" “Cut for 

the Cure” Ruler
•  BERNINA® Serger (optional for 

rolled hem edge finish)
•  Clear Embroidery Foot #34 or 

#34C
•  EZ GLITZER® and EZ Glitz  

Rhinestuds or Rhinestones

“Putting it 
  in Reverse” 
     Appliqué Journal Cover 

By Judy HaHnEr
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To create the appliqué design, select the E and activate Advanced Appliqué. Select Place Fabric 
and Color Patches, click on the + beside Benartex 2006 to expand the folder, then click on Bali’s 
Tutti-Frutti to expand the folder. Select 412-1, then click on the E to fill the letter with fabric. 
Select Back. From Stitch Properties, select Set Stitch Types Manually. Click on the E-shaped 
patch, then select the Cutting Line and Tackdown Run Stitch. Select Back and Close.

Select the E appliqué, hold down the CTRL key and select mbroidery. Click on the Group 
icon, then select Edit and Select All. Click on the Align Centers icon, then 
select View and Slow Redraw. Click on the forward arrow to view the redraw 
process.

Select File and Save As, then Navigate to the folder in which the design will 
be stored. Rename the file and click Save. Select File > Print to print the 
design template. 
     
Stitch the Applique and Embroidery
To determine the amount of fabric needed, measure the journal or 
book to be covered. Measure the width of the book opened, and 
add 3½" extra on each end (a total of 7") for the inside flaps.

Measure the height of the book and add ½" at the upper and lower 
edges (1" total) for hems.

Create a pattern with freezer paper using the above measurements. 
Mark the flap folds and centers of the length and height.

Using the freezer paper pattern, mark the fabric for cutting. Cut the 
fabric 1" larger on all sides; this will 
allow adjustment after embroidering 
the cover design. 

Mark the center of the design, using 
the design template printed from 
the BERNINA® V5 Software to aid in 
positioning.

Prepare the machine for embroidery: 
Insert a fresh Organ Needle and 
thread with embroidery thread. Load 
the design onto machine. Hoop a 
layer of cover fabric, the 6" square of appliqué fabric, and HeavyWeight Cut-Away stabilizer. 

Place the hoop on the machine and stitch the appliqué design.

Remove project from the hoop. Make a small incision inside 
the appliqué design with sharp, short-blade embroidery 
scissors and carefully cut around the inside of the stitching 
line. Curved appliqué scissors are great for getting into the 
corners and curves. When the cutting is completed the 
appliqué fabric is exposed. Do not trim the stabilizer; it will 
serve a dual purpose and give stability to the journal cover.

Complete the embroidery of the cover design.

Construct the Journal Cover
Cut out the journal cover using the pattern created earlier. If fabric has loosened from the 
stabilizer, apply temporary spray adhesive to secure in place. Serge a rolled hem on all edges of 
the book cover. A narrow ¼" hem can be used instead of a serged edge. Another fun edge finish 
can be achieved by straight-stitching ½" from the edges on all sides and letting the raw edges 
ravel, a very popular look right now in ready-to-wear. 

Turn the flaps in on the ends of the 
book jacket, right sides together. 

Stitch ½" seams along the upper 
and lower edges of the flaps, then 
turn the cover right side out.
Press under a ½" seam allowance 
on the remaining edges with a steam 
iron. (If edges were finished with a ¼" 
narrow hem, press under ¼".)

Attach Clear Foot #34/34C to the 
machine and thread the machine 
with a contrasting thread color. 
Select a cross stitch (artista stitch 
#302) from the decorative stitch 
menu. If available, engage the 
Securing Stitch.

Starting at 
the top, place 
the ribbon 
trim along the 
center back 
of the cover, 
extending the 
ribbon ½" 
past the lower 
edge (the 
upper end of the ribbon forms the 
bookmark). Stitch along the length 
of the ribbon, centering it between 
the toes of Clear Foot #34/34C. As 
you near the lower edge of the cover, 
engage the Pattern End and Securing 
Stitch functions to complete and 
secure the decorative stitching.

At the lower edge, topstitch across 
the hem on top of the  
ribbon only to secure  
the hem. 

Open the book and  
insert it into the  
cover.
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